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Introduction

Introduction

This chapter provides information on the purpose of the manual, safety information, and addi-
tional documents and resources.
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Purpose

Purpose

The Class 5 SmartMotor™ Installation & Startup Guide provides an overview of the Class 5
SmartMotor, along with information on unpacking, installation and start up. This guide is
meant to be used in conjunction with the SmartMotor Developer's Guide, which describes the
SmartMotor features, SMI software, programming, commands, and other topics related to
SmartMotor application development.

The information in this guide is meant to be used by properly trained technical personnel only.
Moog Animatics conducts classroom-style SmartMotor training several times per year, as well
as product seminars and other training opportunities. For more information, please see the
Moog Animatics website or contact your Moog Animatics representative.

Combitronic Technology

The most unique feature of the SmartMotor is its ability to communicate with other SmartMo-
tors and share resources using Moog Animatics’ Combitronic™ technology. Combitronic is a
protocol that operates over a standard CAN interface. It may coexist with either CANopen or
DeviceNet protocols. It requires no single dedicated master to operate. Each SmartMotor con-
nected to the same network communicates on an equal footing, sharing all information, and
therefore, sharing all processing resources.

For additional details, see the SmartMotor™ Developer's Guide.

Safety Information

This section describes the safety symbols and other safety information.

Safety Symbols

The manual may use one or more of the following safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard,
where failure to follow the instructions could result in serious injury to the

operator or major damage to the equipment.

CAUTION: This symbol indicates a potential minor hazard, where failure to fol-
low the instructions could result in slight injury to the operator or minor dam-

age to the equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Moog Animatics Class 5 SmartMotor™ Installation & Startup Guide, Rev. A
Page 8 of 70



Other Safety Considerations

Other Safety Considerations

The Moog Animatics SmartMotors are supplied as components that are intended for use in an
automated machine or system. As such, it is beyond the scope of this manual to attempt to
cover all the safety standards and considerations that are part of the overall machine/system
design and manufacturing safety. Therefore, the following information is intended to be used
only as a general guideline for the machine/system designer.

It is the responsibility of the machine/system designer to perform a thorough "Risk Assess-
ment" and to ensure that the machine/system and its safeguards comply with the safety stand-
ards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the locale
where the machine is being installed and operated. For more details, see Machine Safety on
page 9.

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are prop-
erly sized for the specific application. Undersized motors may: perform poorly, cause excess-
ive downtime or cause unsafe operating conditions by not being able to handle the loads
placed on them. The Moog Animatics Product Catalog, contains information and equations that
can be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the
approved and validated system. Specification changes or firmware upgrades require the
approval of the system designer and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating
environment for dust, high-humidity or presence of water (for example, a food-processing
environment that requires water or steam wash down of equipment), corrosives or chemicals
that may come in contact with the machine, etc. Moog Animatics manufactures specialized IP-
rated motors for operating in extreme conditions. For details, see the Moog Animatics Product
Catalog.

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the
machine/system builder must perform a "Risk Assessment"”, which is often based on the ISO
13849 standard. The design/implementation of barriers, emergency stop (E-stop) mech-
anisms and other safeguards will be driven by the Risk Assessment and the safety standards
specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the locale where
the machine is being installed and operated. The methodology and details of such an assess-
ment are beyond the scope of this manual. However, there are various sources of Risk Assess-
ment information available in print and on the internet.

NOTE: The following list is an example of items that would be evaluated when per-
forming the Risk Assessment. Additional items may be required. The safeguards
must ensure the safety of all personnel who may come in contact with or be in the
vicinity of the machine.

In general, the machine/system safeguards must:

« Provide a barrier to prevent unauthorized entry or access to the machine or system. The
barrier must be designed so that personnel cannot reach into any identified danger
zones.
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Documentation and Training

Position the control panel so that it is outside the barrier area but located for an unres-
tricted view of the moving mechanism. The control panel must include an E-stop mech-
anism. Buttons that start the machine must be protected from accidental activation.

Provide E-stop mechanisms located at the control panel and at other points around the
perimeter of the barrier that will stop all machine movement when tripped.

Provide appropriate sensors and interlocks on gates or other points of entry into the pro-
tected zone that will stop all machine movement when tripped.

Ensure that if a portable control/programming device is supplied (for example, a hand-
held operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional
system design considerations and safeguards beyond those listed in this sec-
tion. For details, see the safety standards specified by the governing author-
ity (for example, ISO, OSHA, UL, etc.) for the locale where the machine is
being installed and operated.

Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys,
tooling, etc.).

Prevent contact with a part that is thrown from the machine tooling or other part-hand-
ling equipment.

Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other
hazards that may be present at the machine.

Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.

Provide a proper control system, program logic and error checking to ensure the safety
of all personnel and equipment (for example, to prevent a run-away condition). The con-
trol system must be designed so that it does not automatically restart the machine/sys-
tem after a power failure.

Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety,
operation, maintenance and programming, along with training for all machine operators, main-
tenance technicians, programmers, and other personnel who may have access to the

machine. This documentation must include proper lockout/tagout procedures for maintenance
and programming operations.

It is the responsibility of the operating company to ensure that:

All operators, maintenance technicians, programmers and other personnel are tested
and qualified before acquiring access to the machine or system.

The above personnel perform their assigned functions in a responsible and safe manner
to comply with the procedures in the supplied documentation and the company safety
practices.

The equipment is maintained as described in the documentation and training supplied by
the machine/system designer.
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Additional Equipment and Considerations

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the
need for additional equipment. In general, it is the responsibility of the operating company to
ensure that:

« Unauthorized access to the machine is prevented at all times.

« The personnel are supplied with the proper equipment for the environment and their job
functions, which may include: safety glasses, hearing protection, safety footwear,
smocks or aprons, gloves, hard hats and other protective gear.

« The work area is equipped with proper safety equipment such as first aid equipment,
fire suppression equipment, emergency eye wash and full-body wash stations, etc.

» There are no modifications made to the machine or system without proper engineering
evaluation for design, safety, reliability, etc., and a Risk Assessment.

Safety Information Resources

Additional SmartMotor safety information can be found on the Moog Animatics website; open
the file "109_Controls, Warnings and Cautions.pdf" located at:

http://www.animatics.com/support/moog-animatics-catalog.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html

ANSI-RIA robotic safety information can be found at:

http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:

http://www.ul.com/global/eng/pages/solutions/standards/accessstandards/
catalogofstandards/

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/enterprise/policies/european-standards/harmonised-standards/
index_en.htm
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Additional Documents

Additional Documents

The Moog Animatics website contains additional documents that are related to the information
in this manual. Please refer to the following list:

o SmartMotor™ Developer's Guide

http://www.animatics.com/support/download-center.html

e SmartMotor™ Product Certificate of Conformance

http://www.animatics.com/download/Animatics_SmartMotor_Servida_Class_5_Declar-
ation_of Conformity CE_Rev_1.pdf

o SmartMotor™ UL Certification

http://www.animatics.com/download/MA_UL online_listing.pdf

o SmartMotor Developer's Worksheet
(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port
Status, Serial Port Status, RMODE Decoder and Syntax Error Codes)

http://www.animatics.com/support/download-center.html

If you do not have internet access, a static version of the worksheet items can be found
in the Appendix of the SmartMotor™ Developer's Guide.

« Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html

Additional Resources

The Moog Animatics website contains additional resources such as product information, doc-
umentation, product support and more. Please refer to the following list:

» General company information:

http://www.animatics.com

e Product information:

http://www.animatics.com/products.html

» Product support (Downloads, How To videos, Forums, Knowledge Base, and FAQs):

http://www.animatics.com/support.html

« Sales and distributor information:

http://www.animatics.com/sales-offices.html
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Additional Resources

« Application ideas (including videos and sample programs):

http://www.animatics.com/applications.html|
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SmartMotor Overview

SmartMotor Overview

This chapter provides an overview of the design philosophy and functionality of the Moog Anim-
atics SmartMotor. It also provides information on SmartMotor features and options, and
where to find related documents and additional resources.

SmartMotor Introduction ... 16
SmartMotor Features and Options ... ... . 17
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DE Power Option (D-Style MotOrs) ... L 23
IP65 and IP67 M-Style MOtOrS . . 24
SmartMotor Theory of Operation ... . ... .. 25
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SmartMotor Introduction

SmartMotor Introduction

The Moog Animatics SmartMotor™ servo is an industrial servo motor with motion controller
integrated into a compact package. Its design is based on the following objectives:

1. Reduce development time
2. Lower machine-production cost

3. Simplify the machine, machine build and support

D-Style Cast and Extruded SmartMotors

NOTE: Information in this guide applies to both the cast and extruded motors.

M-Style SmartMotors
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SmartMotor Features and Options

The SmartMotor is powerful and unique because of its ability to control an entire machine. The
combination of programmability, networking, I/0 and servo performance is unmatched. The
SmartMotor brings savings and value to the machine builder by removing complex and costly
elements in the machine design, such as PLCs, sensors, I/0 blocks, cabinets, etc.

SmartMotor Features and Options

The Class 5 SmartMotor is available in D-style and M-style configurations. All SmartMotors
offer the following features:

« Full floating-point math and trigonometric functions with 32-bit precision results

- Dual trajectory generators enabling relative and absolute position moves or velocity
moves on top of gearing or camming

» Advanced gearing allowing preset traverse and take-up winding parameters including
dwells and wrap counts

» Advanced camming including cubic spline interpolation and dynamic frequency and amp-
litude changes.

» Stand-alone, multi-axis linear interpolation with as many as 120 SmartMotors at a time

« Virtual-axis mastering into camming through gearing, which enables stand-alone,
multi-axis coordinated motion

« Programmable and non-programmable protection features (both hardware and soft-
ware)

The following sections describe the similarities and differences between the D-style and
M-style configurations.

In addition to this information, there is Product Foldout available on the Moog Animatics web-
site, which illustrates the standard and optional features of the D-style and M-style motors. To
access the foldout, use the following address:

http://www.animatics.com/support/download-center.html

and select the Product Info Center tab.
A note about SmartMotor part numbers:

The SmartMotor uses a coded part humber, which contains characters that describe the motor
number, frame style and options. For details on decoding the SmartMotor part humber, refer
the Moog Animatics Product Catalog at this address:

http://www.animatics.com/support/moog-animatics-catalog.html

and select the file: 14_Understanding Part Numbers.pdf.

D-Style Motors
All D-style SmartMotors have:

o A primary RS-232 communications port
« A secondary RS-485 communications port

« Seven channels of 5 VDC TTL non-isolated I/0
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D-Style Motors

« Ten optional channels of expanded 24 VDC isolated I/0
« A dedicated, single-ended encoder output

The following industrial (Fieldbus protocol) communications options are available on the
D-style motors. (Availability varies by model number; see the Moog Animatics Product Cata-
log for details.)

« CANopen option
« PROFIBUS option
« DeviceNet option
For more details, see Fieldbus Options on page 20.
All firmware options include:
« Modbus Remote Terminal Unit (RTU) Slave (RS-485 COM 1)
« DMX Slave (RS-485 COM 1)

In addition, a hardware DE power option is available, which allows the controller and drive
amplifier to be powered from separate power sources. For more details, see DE Power Option
(D-Style Motors) on page 23.

CAUTION: For D-style SmartMotors, pins 14 and 15 of the 15-pin D-sub port

are intended for use with DE series motors for control power only. Attempts to
power a non-DE motor through those pins as main servo drive power could res-
ult in immediate damage to the electronics and will void the warranty.

The D-style motors are available in the following NEMA frame sizes:
« NEMA 17

« NEMA 23
« NEMA 34

The following figure shows the connector and LED locations for the D-style motors. For details
on the D-style motor connectors, see D-Style Motors: Connectors and Pinouts on page 37. For
details on the LED functions, see Understanding the Status LEDs on page 47.
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M-Style Motors

15-Pin D-Sub I/0

Power/Servo LED

7-Pin Combo D-Sub
Power & I/0

Trajectory LED

CAN Fault LED

CAN Connector
CAN Status LED

Expanded I/0 Connector
D-Style Motor Connectors and LEDs

M-Style Motors

All M-style SmartMotors have:
o A primary RS-485 communications port
» Eleven channels of general purpose 24 VDC isolated I/0O
« A dedicated Drive-Enable Input and NOT-FAULT Output
« A dedicated differential £5V encoder bus

The following industrial (Fieldbus protocol) communications options are available on the
M-style motors. (Availability varies by model number; see the Moog Animatics Product Cata-
log for details.)

« CANopen option
« DeviceNet option
NOTE: The PROFIBUS fieldbus protocol is not available on the M-style motors.
All firmware options include:
« Modbus Remote Terminal Unit (RTU) Slave (RS-485 COM 0)
« DMX Slave (RS-485 COM 0)

In addition, a hardware DE power option is available, which allows the controller and drive
amplifier to be powered from separate power sources. For more details on the Fieldbus and
DE options, see Fieldbus Options on page 20 and DE Power Option (D-Style Motors) on page
23.

The M-style motors are available in the following NEMA frame sizes:
« NEMA 23

« NEMA 34
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Fieldbus Options

The following figure shows the connector and LED location for the M-style motors. For details
on the M-style motor connectors, see M-Style Motors: Connectors and Pinouts on page 44. For
details on the LED functions, see Understanding the Status LEDs on page 47.

5-Pin Limit Inputs

CAN Fault LED

CAN Connector

y B -‘ /
V CAN Status LED

8-Pin COM Encoder Bus

Power/Servo LED
Trajectory LED
4-Pin Power Input

12-Pin 1/0 Connector

M-Style Motor Connectors and LEDs

Fieldbus Options

This section details the Fieldbus communications protocol options that are available on certain
models of SmartMotors.

CANopen Fieldbus Protocol
NOTE: This protocol is available on D-style and M-style motors.
The CANopen fieldbus protocol provides the following features:
« All basic Motion commands available through the CiA V4.02 specification
« Ability to read/write all SmartMotor variables

« Use of on-board I/0O through CANopen gateway, SmartMotor program or serial com-
mands

« Ability to run 1000 SmartMotor subroutines through CANopen

« Online diagnostics of the SmartMotor through SMI software and serial connection
« Upto 127 nodes

» 250 microsecond interrupt-driven subroutine

« Baud rates of 20 Kbps, 50 Kbps, 125 Kbps (default), 250 Kbps, 500 Kbps and 1 Mbps
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DeviceNet Fieldbus Protocol

The following figure shows the location of the CANopen port and the corresponding pinouts.

5-Pin CANopen Connector
(female is standard)

CANopen Pinout:

Not Connected

+V (not connected)
-V (ground)

CAN-H

CAN-L

AL WON-=-

NOTES:

Pin 2 is not connected, except on DeviceNet systems.
Pin 3 is isolated on D-style motors and unisolated on M-style motors.
Male connector is an option on M-style motors.

CANopen Connector Location and Pinouts

For more connector/pinout details, see Connecting the System on page 36
DeviceNet Fieldbus Protocol
NOTE: This protocol is available on D-style and M-style motors.
The DeviceNet Fieldbus protocol provides the following features:
« Polled I/O and Explicit Messages from your PLC to control all SmartMotor operation

« Read/write control over all Open DeviceNet Vendor Association (ODVA)
position-controller parameters

« Use of on-board I/0 through DeviceNet, SmartMotor program or serial commands

« Ability to run 1000 SmartMotor subroutines through DeviceNet and read/write four
32-bit user variables

« Online diagnostics of the SmartMotors through SMI software and serial connection
« Up to 64 DeviceNet nodes
» 250 microsecond interrupt-driven subroutine

« Baud rates of 125 Kbps, 250 Kbps and 500 Kbps (the default is 125 Kbps)
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PROFIBUS Fieldbus Protocol

The following figure shows the location of the DeviceNet port and the corresponding pinouts.

M-Style

5-Pin DeviceNet Connector
(female is standard)

DeviceNet Pinout:

1 Not Connected

2 +24V (connected)
3 -V (ground)

4 CAN-H

5 CAN-L

NOTES:
Pin 2 is connected only on DeviceNet systems; input current < 10mA.
Pin 3 is isolated on D-style motors and unisolated on M-style motors.
Male connector is an option on M-style motors.

DeviceNet Connector Location and Pinouts

For more connector/pinout details, see Connecting the System on page 36

PROFIBUS Fieldbus Protocol
NOTE: The PROFIBUS fieldbus protocol is not available on the M-style motors.
The PROFIBUS fieldbus protocol provides the following features:
« Command/Response Codes for all Class 5 SmartMotor commands
» Use of on-board I/0 through PROFIBUS, SmartMotor program, or RS-232 commands
« Ability to run 1000 SmartMotor subroutines through PROFIBUS
« Ability to read/write all SmartMotor variables
« Online diagnostics of the SmartMotors through SMI software and RS-232 connection
« Upto 127 PROFIBUS nodes
» 250 microsecond interrupt-driven subroutine

» Baud rates of 9.6 Kbps, 19.2 Kbps, 31.25 Kbps, 45.45 Kbps, 93.75 Kbps, 187.5 Kbps,
500 Kbps, 1.5 Mbps, 3 Mbps, 6 Mbps and 12 Mbps (the default is 1.5 Mbps)
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DE Power Option (D-Style Motors)

The following figure shows the location of the PROFIBUS port on the D-style motor and the cor-
responding pinouts.

N\ NOIQIOIOIO) )
@ @

9-Pin, D-sub PROFIBUS Connector

PROFIBUS Pinout:

1 SHIELD DRAIN, 6 +5V
HIGH IMPEDANCE 7 NC

2 NC 8 BUS-A

3 BUS-B 9 NC

4 RTS

5 GROUND

PROFIBUS Connector Location and Pinouts on D-Style Motor

DE Power Option (D-Style Motors)

The D-style SmartMotor's hardware DE power option allows the controller and drive amplifier
to be powered from separate DC power supplies (see the following figure). For a schematic
diagram, see D-Style Motors: DE Power Option Schematic on page 41.

This hardware option provides the following advantages:

Controller can be powered from a standard 24-48 VDC power supply
Position will not be lost if drive power is lost

No need to re-home

Load surges will not cause a power surge on the controller

Standard battery options are made simpler

NOTE: All M-style and IP-sealed SmartMotors are designed to a/lways have sep-
arate drive and control power. Therefore, no DE designation is available for these
SmartMotors.
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IP65 and IP67 M-Style Motors

The following figure shows the connectors used for the DE power option.

Control power supplied to this
connector (20-48 VDC)

Drive Amp power supplied to
this connector (20-48 VDC)

NOTE: The same power supply may be
used for Control and Drive power, but
maximum protection is provided with
separate power supplies.

D-Style SmartMotor Showing DE Power Option

As noted in the previous figure, although you can supply the control and drive power from one
power supply, you will only get the full benefits and maximum protection by using separate
power supplies.

IP65 and IP67 M-Style Motors

Certain models of M-style SmartMotors are available in IP-rated versions (see the Moog Anim-
atics Product Catalog for details). The standard IP rating is IP65, which protects the motor
from dust particles and splashing water. Additionally, certain motors can be ordered with the
higher IP67 rating. Contact Moog Animatics for details.

IP ratings are in accordance with the code defined in international standard IEC 60529.
Instead of the vague descriptions of "waterproof"”, "water-resistant" or "dustproof”, the IP-rat-
ing system provides a uniform, quantifiable set of standards to which each product is rig-
orously tested. The IP code refers to the degree of protection for the electrical enclosures on a
machine against liquid, solid objects and particulates. The first number following "IP" refers to
the level of protection of the hazardous parts and electrical enclosures against solid objects
and particulates, and the second digit indicates the level of water resistance. The higher the
first digit rating in the IP system, the smaller the foreign object that it is protected against.

SmartMotors with the IP65 rating are both completely dust tight and protected from ingress of
liquid that may occur from any angle, rendering no harmful effects on the electrical enclosure.
SmartMotors with the IP67 rating can be submersed in water or other non-hazardous liquids
to a depth of one meter for a maximum time of 30 minutes. Therefore, conditions with high
levels of humidity and condensation are no longer a problem. The IP-rated models provide the
perfect integrated servo for food and beverage manufacturing and packaging, rugged outdoor
conditions, as well as any wet environment.
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SmartMotor Theory of Operation

Note that there are special IP-rated cables, which are available from Moog Animatics, that are
designed for use with the IP-rated SmartMotors. The following figure shows the cables, part
numbers and corresponding connections.

NOTE: LED operation is the same as standard (non-IP rated) SmartMotors.
CBLIP-LIM-FL (5 Pin)

1 :%

CBLIP-CAN-FL (5 Pin)

0 1

)‘/ , ——

@

ki w & _ml

PC/RS-232

Y\ CBLIP-COM-FL (8 Pin)
ﬂw:mﬁm:&e:é

=4
p) 1]

RS232485T

CBLIP-PWR4-FL (4 Pin)
B ——— =—

CBLIP-IO-FL (12 Pin)
m&m:&:é

IP-Rated Cables and Connections

SM34165M/MT <— 24V - 48V Drive Power

<€— Separate 24V Control Power

SmartMotor Theory of Operation

The Moog Animatics SmartMotor is an entire servo control system built inside of a servo
motor. It includes a controller, an amplifier and an encoder. All that is required for it to oper-
ate is power and either an internal program or serial commands from outside (or both). To
make the SmartMotor move, the program or serial host must set a mode of operation, state a
target position with/or a maximum velocity at which to travel to that target, and a maximum
acceleration. After these three parameters are set, and the two limit inputs are properly
grounded or deactivated, a "Go" command starts the motion profile.

The core functional areas of the SmartMotor are:

« Motion Control Functions (see Motion Details in the SmartMotor™ Developer's Guide)

» System Control Functions (see Program Flow Details in the SmartMotor™ Developer's
Guide, also see System Status in the SmartMotor™ Developer's Guide)

« Communication Functions (see Communication Details in the SmartMotor™ Developer's
Guide)

« I/O Functions (see I/O Control in the SmartMotor™ Developer's Guide)
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SmartMotor Theory of Operation

The following block diagram illustrates the relationship between the functional areas in the

SmartMotor.
VI= AT= DI= G, X, OFF, S .
PT= PRT= ADT= MTB !
l : Control
. ‘/f‘\ Vel J* KV : on’off Not supported on
Trajectory1 /M pyo KA : D-series motors
14 ccel % |
mp | mv | mp ! [K11] [xP1]
}
I ! Torque
— [P lexrp N command
Traiectory 2 RPC S 7 g
jectory HD——O L= Kixedt KL !
mC | MFR | MsR - !
RPA filter - !
KS D |kD* 5 :
1 Current
Cam + Sensors
function' ® Motor
— PWM
l g g Encoder
External RCTR(0) N Hall sensor
Encoder {
Follow mﬁ g Commutation
9]
Profile |N¥i &
M
Internal 4 SRC(2)
Clock: SRC(1)
1 tick per SRC(0) —
PID cycle [ -1} — SRC(-1) —
|' % -1 |' SRC(-2) —o
NOTES:

1. MFMUL and MFDIV commands do not have an effect on dwell time or distance. Dwell is strictly based on raw master encoder counts selected by the

SRC() command specifying internal virtual or external master count source.
2. When feeding a Cam table with a gearing profile, changes to MFMUL and MFDIV will affect the time it takes to move through a Cam table but will not
affect dwell time, as specified in the previous note.

SmartMotor Theory of Operation Diagram
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Getting Started

Getting Started

This chapter provides information on getting started with your SmartMotor.

Unpacking and Verifying Your Shipment ... . 29
Installing the SMI Software .. ... 29
Installation Procedure . 29
Installation Verification ... . 32
Accessing the SMI Software Interface ... ... . ... 32
Understanding the Power Requirements ... ... ... . ... 33
SmartMotor Power ReqUIiremMents .. L 33
D-Style CPU, I/O and Communications Power ... ... . 34
CPU Power ReqUIremMENS oo 34
I/O Power Requirements .. il 34
Communications Power Requirements .. ... 34
M-Style CPU, I/O and Communications POWEr ... . 35
CPU Power ReqUirements oo e 35
I/O Power RequiremMents .. 35
Communications Power Requirements .. . .. 35
M-Style Drive Enable POWer . il 35
Connecting the System L 36
Minimum ReqUiremMeNntS il 36
D-Style Motors: Connectors and Pinouts ... ... . 37
D-Style Motors: Demo or Development System .. ... 37
D-Style Motors: RS-232 Through USB .. . 38
Adding a USB Adapler ..o 38
D-Style Motors: RS-232 with Protective Shunt ... .. 40
D-Style Motors: RS-232 Multidrop with Add-A-Motor Cables ... ... ............... 41
D-Style Motors: RS-232 Multidrop with Custom X-Y-Z Cable ... .. ... ...................... 41
D-Style Motors: DE Power Option Schematic .. ... ... ... 41
D-Style Motors: CDS Option Schematic ... ... .. 42
M-Style Motors: Connectors and Pinouts ... ... . ... 44
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Getting Started

M-Style Motors: Power, RS-485 Com and CAN Multidrop ... ..., 44
M-Style Motors: Power MUltidrop ... ... 45
M-Style Motors: RS-232 to RS-485 Multidrop ... ... . 45
M-Style Motors: CANopen or DeviceNet Multidrop ... ... ... 46
Understanding the Status LEDS ... . . il 47
Detecting and Addressing the SmartMotors ... .. .. 48
Understanding the Detection and Addressing Options . ... . .. i, 48
Using the Find Motors BUttON .. 50
Using the Detect Motors Feature .. .. 52
Using the Address Motors Feature ... . 54
Checking and Clearing the Status Bits ... ... ... ... ... .. ... 56
Polling the MOtOr .. . 57
Clearing the Overtravel Limits and Fault Bits ... ... ... ... . ... 58
Moving the SmartMotor il 59
Making the Motor MOVe . L 59
Setting and Reporting TorquUe ... . 60
Checking the Motor Position . .. . 61
Viewing the Motor Position with a Report Command ... ... ... ... ... ... ... 61
Viewing the Motor Position with the Motor View Tool ... . ... .. ... ... ... 61
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Unpacking and Verifying Your Shipment

Unpacking and Verifying Your Shipment

Your Moog Animatics SmartMotor and accessories are carefully assembled, tested, inspected
and packed at the factory.

When you receive your shipment, you should immediately do the following:

« Visually inspect all shipping containers for visible signs of shipping damage. If you see
damage, please notify your carrier and then contact Moog Animatics to report the prob-
lem.

« Carefully unpack each component and verify the part number with your order. If there
are any differences or missing items, please contact Moog Animatics so that the ship-
ment can be corrected.

» As you are unpacking the shipment, please keep all boxes and packing materials. These
may be needed for future storage or shipment of the equipment.

Installing the SMI Software

The SmartMotor Interface software (SMI software) provides a convenient user interface for
programming the SmartMotor. Before you can use the SMI software, it must be installed on a
Microsoft Windows PC.

The SMI software is distributed on CD-ROM and is also available as a download from the Moog
Animatics website. To download the latest version of the SMI software, use the following
address:

http://www.animatics.com

Then click the SMI Download button at the top of the page.

[ SMi- cowniond | Gl e AN | Lo

NMOOG

==+ ANIMATICS L

SMI Download Button

The installation package is downloaded to your system.

NOTE: The SMI software requires Microsoft Windows XP or later.

Installation Procedure

To install the SMI software:

1. Double-click the executable package (.MSI) file to begin the installation. In some ver-
sions of Microsoft Windows, you may receive a security warning message about running
the file. You can ignore this message.

If this is a new installation, go to the next step.
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Installation Procedure

If this is an upgrade to a previous installation, you will see the following window. Select
Remove, click Next and follow the instructions to remove the existing software from

Application Maintenance
Select the maintenance operabon to perform

Version 24,32  (with IntegMotorinterface 2.2.1.1)

Change which applicabion features are nstalled. Displays the
Select Festuies dalog, which lels you configue indridual fealunes

Feinstall mizsing or coeupt fles, registn keps, and shorcuts
Praferences stored in the regestiy may be resat to defaul values.

ﬂ Urinztall Smarthator [nterface from this compuber,

Wise Installation Wizard (R)

After removing the existing software, restart the installation process.
NOTE: All personal settings and user files will be retained.

2. Click Next to proceed. The Installation Configuration page opens.

¥Yersion 24.32  (with IntegMotorinterface 2.2.1.1)

Select desired langusge. | English

"wiise Instalation \wWizad®
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Installation Procedure

3. Click Next to proceed. The SMI software installation wizard starts and the Welcome
page opens.

Welcome to the SmartMotor
Interface Installation Wizard

It iz shangh recommendsd thal vou exit 8l Windows progeams
be=fore running this setup program

Click Cancal bo quit the setup progranm, then chase anp programs
yous have wnning. Click Next bo cortinue the installstion.

WARNIMG: Thiz program i probected by copynght law and
nbeenational lieaties,

Unauthorized repeaduction oo distribution of this program, oo sy
portion of &, may result in severe cral and cimnal penales, and
will be prozeculed to the masimum extent possible under lew.

4. After you have finished reviewing the welcome information, click Next to proceed.
Continue following the on-screen instructions to complete the SMI software installation.

5. When the installation has completed, the installation status message page opens, as
shown in the following figure. Click Finish to complete the installation and close the
installation wizard.

SmartMotor Interface has been
successfully installed.

Click: the Finish butlon Lo el this installstion.

NOTE: After the software is installed, be sure to restart your computer before run-
ning the SMI software.
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Installation Verification

Installation Verification

To verify the installation, navigate to the C:\Programs folder. You should see the following dir-
ectory structure:

4  Animatics
» L SMIZ2

Accessing the SMI Software Interface

The SmartMotor Interface software (SMI software) communicates with a single or series of
SmartMotors from a Windows-based PC and gives you the capability to control and monitor
the status of the motors. The SMI software also allows you to write programs and download
them into the SmartMotor’s long-term memory.

NOTE: Every SmartMotor has an ASCII interpreter built in. Therefore, it is not
necessary to use the SMI software to operate a SmartMotor.

To open the SMI software, double-click the SmartMotor Interface shortcut on the Windows
desktop.

[SM
[J==

SmartMotor
Interface

SmartMotor Interface Shortcut

Optionally, to open the SMI software from the Microsoft Windows Start menu, select:
Start > All Programs > Animatics > SMI2 > SmartMotor Interface

The SMI software interface opens, as shown in the following figure.

Menu bar —

Toolbar 2
E) s [= [ & =

/

Comd | Com  Comb | Ethemet | USE | C&N Channel0 |

¥ Open [ailMotors —~|[ComB 3500RSZ32ChOBNL—
[ Send |

Configuration
window

oS (R5232 3600 bps)
| Com8 [R5232-9500 bps)

/ & USB

. Ethemet
Terminal ' . CAN Channel 0125000 bps)

WindOW /

Program /

editor

Information
window

For Help, press F1 Version:5.0.2 Ln1, Coll

SMI Software Interface
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Understanding the Power Requirements

NOTE: In addition to the software information in this section, there is context-sens-
itive help available within the SMI software interface, which is accessed by press-
ing the F1 key or selecting Help from the SMI software main menu.

The following are the primary features in this interface:

« Menu Bar: All of the windows and functions of the SMI software can be accessed through
the menu bar. Many of these are also accessible through the icons on the toolbar.

» Toolbar: The toolbar contains a collection of icons for accessing the primary features of
the SMI software. Depending on the current state of the SMI software and the currently-
active window, some toolbar buttons may be disabled.

« Configuration Window (far-left window): This window is used to display the current com-
munication and detected motor configuration when no project is open, or the com-
munication and motor configuration defined in an open project.

« Terminal Window (middle window): This window is used to communicate with SmartMo-
tors (for example, issue single-line commands to one or all motors). The response (if
any) is also shown in this window.

« Information Window (lower window): This window is used to display the results of user
operations.

« Program Editor (far-right window): This window is used to manage, edit and print user
programs. Most of the procedures for using the editor should seem familiar if you have
used other Windows-based text editors.

For more details about these items, see SMI Software Features in the SmartMotor™
Developer's Guide.

Understanding the Power Requirements

This section describes the power requirements for SmartMotor power, CPU power, I/O power
and Communications power.

SmartMotor Power Requirements

Requirement: The power range for D-style SmartMotors is from 24 VDC to 48 VDC; do not
exceed 48 VDC. For the D-style AD1 option, do not exceed 24 VDC.

For M-style SmartMotors: control power requires 24 VDC, do not exceed 24 VDC; motor
power requires from 24 VDC to 48 VDC, do not exceed 48 VDC.

CAUTION: Control power for M-style motors must be 24 volts. They are not
rated for 48 volts.

Details: Some of the larger SmartMotors can draw high current. Therefore, heavy gauge wire
is required to connect the large motors. As a result, Add-A-Motor cables are only recom-
mended for series 17 and 23 motor frames.

Voltages below 18 VDC could cause a brownout shutdown of the CPU, or what would appear as
a power-off reset, under sudden load changes.

CAUTION: If power is reversed on any standard SmartMotors, immediate
damage WILL occur and the SmartMotor will no longer operate.
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D-Style CPU, I/0 and Communications Power

When relying on torque/speed curves, pay close attention to the voltage on which they are
based.

During hard, fast decelerations, a SmartMotor can pull up supply voltages to the point of dam-
age if a shunt resistor pack is not used. Protective shunts are available from Moog Animatics.

Special care must be taken when near the upper voltage limit or in vertical applications that
can back-drive the SmartMotor. Gravity-influenced applications can turn the SmartMotor into
a generator and back-drive the power supply voltage above the safe limit for the SmartMotor.
Many vertical applications require a shunt to protect the SmartMotor from damage. Protective
shunts are available from Moog Animatics.

CAUTION: Many vertical applications and applications with hard, fast decel-
erations require shunts to protect the SmartMotor from damage. Note that
shunts should always be placed between the motor input and any disconnect or

E-stop relay to protect the motor when power is off or E-stop relay contacts
are open.

D-Style CPU, I/0 and Communications Power

CPU Power Requirements

Requirement: Maximum of 5 VDC on any I/O pin or 5 VDC pin.

Details: D-style SmartMotors have an internal 5 VDC power supply to run the internal CPU.
This supply can be easily damaged if an external voltage source of a higher voltage potential
is applied. Therefore, do not exceed 5 VDC on any TTL-level I/O pin or 5 VDC pin.

I/0 Power Requirements

Requirement: Maximum sink amperage = 12 mA; Maximum source amperage = 4 mA.

Details: Each on-board 5-volt I/O pin has a minimum amount of protection consisting of a
100 ohm current-limit resistor and a 5.6 VDC Zener diode. Each I/O pin also has a 5 kohm
pull-up resistor. When assigned as outputs, they act as a push-pull amplifier that drives hard
to either the positive or negative 5 VDC rail. This means they are not open-collector I/0 pins.
Each I/0 pin can sink up to 12 mA and source up to 4 mA. Exceeding this could result in dam-
age to the I/0 port.

The AD1 option on the D-series motor provides isolated 24-Volt I/O. The user must supply the
24 volts at the appropriate pin on the round 12-pin connector.

CAUTION: For Class 5 D-style AD1 option motors, at no time should the
voltage to any input exceed the level on the I/O power input (Pin 11). Doing

so could cause immediate damage to the expanded I/O hardware.

Communications Power Requirements

Requirement: Proper serial ground signal referencing and shielding techniques are required;
do not use the cable shield for the RS-232 ground reference.

Details: The D-style SmartMotor has a two-wire RS-232 port. This port meets IEEE standards
with full +/-12 VDC potential on the transmit line. Proper serial ground signal referencing and
shielding techniques must be used. Under no circumstances should the shield of a cable be
used for the RS-232 ground reference. This could result in noise or corrupt data as well as
ground loops that could damage the serial port chip set.
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M-Style CPU, I/O and Communications Power

M-Style CPU, I/0 and Communications Power

CPU Power Requirements
Requirement: Nominal 24 VDC (£20%) must be supplied. Do not exceed 32 VDC.

Details: The CPU Details: Power is supplied from the "control" power input (pin 1) on the 4-
pin power input connector.

I/0 Power Requirements
Requirement: Nominal 24 VDC (£20%) must be supplied. Do not exceed 32 VDC.

Details: The 1/0 Details: Power is supplied from the "control" power input (pin 1) on the 4-
pin power input connector.

NOTE: This I/O is not isolated from the CPU's power supply and the motor drive.

Communications Power Requirements
Requirement: Nominal 24 VDC (£20%) must be supplied. Do not exceed 32 VDC.

Details: The RS-485 signal Details: Power is supplied from the "control" power input (pin 1)
on the 4-pin power input connector.

NOTE: The RS-485 signal is not isolated from the CPU's power supply or the motor
drive.

M-Style Drive Enable Power

The Drive Enable input on the M-series motor must be connected and activated with 24V. For
the input location, see M-Style Motors: Connectors and Pinouts on page 44.
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Connecting the System

Connecting the System

The following sections show system connections and cable diagrams for typical D-style and
M-style motor installations.

For D-style motors:

« D-Style Motors: Connectors and Pinouts on page 37

« D-Style Motors: Demo or Development System on page 37

« D-Style Motors: RS-232 Through USB on page 38

« D-Style Motors: RS-232 with Protective Shunt on page 40

« D-Style Motors: RS-232 Multidrop with Add-A-Motor Cables on page 41
« D-Style Motors: RS-232 Multidrop with Custom X-Y-Z Cable on page 41
« D-Style Motors: DE Power Option Schematic on page 41

For M-style motors:

« M-Style Motors: Connectors and Pinouts on page 44

« M-Style Motors: Power, RS-485 Com and CAN Multidrop on page 44
« M-Style Motors: RS-232 to RS-485 Multidrop on page 45

« M-Style Motors: CANopen or DeviceNet Multidrop on page 46

As you can see, many configurations are possible.

« If you are using one of these typical configurations and Moog Animatics-supplied cables,
simply follow the connection information in this section.

. If you are using your own cables or a non-typical configuration, review the cable dia-
grams and also see the detailed connector and pinout descriptions in D-Style Motors:
Connectors and Pinouts on page 37 and M-Style Motors: Connectors and Pinouts on page
44,

Additionally, see the Moog Animatics website for other cabling options:

http://www.animatics.com/supports/knowledge-base/connectivity-map.html

Advanced communication information is available in Communication Details in the SmartMo-
tor™ Developer's Guide.

Minimum Requirements
At minimum, you will need the following items:

1. A Class 5 D-style or M-style SmartMotor

2. A computer running Microsoft Windows and the SMI software

3. A DC power supply and power cable for the SmartMotor

4. A data cable to connect the SmartMotor to the computer’s serial port or serial adapter

NOTE: First time users of the SM1700 through SM3400 series motors should pur-
chase the Moog Animatics SMDEVPACK-D. It includes the CBLSM1-3M data and
power cable, the SMI software, the manual and a connector kit.
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D-Style Motors: Connectors and Pinouts

D-Style Motors: Connectors and Pinouts

The following figure provides a brief overview of the connectors and pinouts available on the
D-style SmartMotors. Additional connector specifications are available in Class 5 D-Style Con-
nector Pinouts on page 66.

876 54321

2
=4

DESCRIPTION

1/0-0 12-Pin Expanded I/O Connector

1/0-1

1/0-2 151413121110 9 g o PIN_| DESCRIPTION

0 [N oy U | B w o=

1 [I/o16GP

1/0-3 . 7

/04 15-Pin D-Sub 1/0 L 2 | I/O17GP

V0 6 10 1/0-18 GP

1/0-6 S 2 1/0-19 GP
1= 143 1/0-20 GP

9 | Encoder B Out
1/0-22 GP

3
4
Encoder A Out 5
6 1/0-21 GP
7
8

10 | RS-232 Transmit
1/0-23 GP

11 | RS-232 Receive

12 | +5VDC Out 9 | 1/0-24GP

13 | Ground 10 | I/0-25GP

14 | Power Ground 11 | +24VDC Input
15 | Power 12 | GNDI/O

Trajectory LED—

PWR/Servo LED

CAN Fault LED

PIN | DESCRIPTION 5-Pin CAN (fe';1|§|T)E’ESCRIPTION
2; ;20‘“% +48VdDC 7-Pin Combo D-Sub Power & 1/O e
ower Groun

1 1/0-6 2 | +V(NC except DeviceNet)
2 [ +5VDCOut 0D ‘ 3 |-V (solated GND)

3 RS-232 Transmit °j ®@® 0] 4 | CAN-H

4 | RS-232 Receive 5 |CAN-L

5 RS-232 Ground

NOTE: The DE power option is recommended. For details, see D-Style Motors:
DE Power Option Schematic on page 41.

CAUTION: For Class 5 D-style AD1 option motors, at no time should the
voltage to any input exceed the level on the I/O power input (Pin 11). Doing

so could cause immediate damage to the expanded I/0 hardware.

D-Style Motors: Demo or Development System

CAUTION: This configuration is designed for development, training or demo
purposes only. It is not intended for use in an industrial (manufacturing) envir-

onment.
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D-Style Motors: RS-232 Through USB

CBLSM1-DEMO

j/ PWR116V

D-Style Motors: RS-232 Through USB

KITUSB232485 CBLSM1-xM

PS24V8AG-110
or PS42V6AG-110—

Adding a USB Adapter

Moog Animatics sells a USB to Serial adapter (PN KITUSB232485), which is used on PCs that
don't have a built-in serial port. The adapter allows you to connect from an available USB port
to the serial interface on the SmartMotor. The adapter simply connects between the USB port
and the serial cable.

When the adapter is used, it is recommended that you use the Microsoft Windows Device Man-
ager's Port Settings tab to change the port's communications buffers to minimum. This allows
the operating system to immediately notify the SMI software when data is being received
from a SmartMotor. Otherwise, you may experience intermittent interruptions in com-
munications.

To change the USB port settings:
1. From the Windows Desktop, open the Device Manager by selecting:

Start > Control Panel > Device Manager
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Adding a USB Adapter

2. Scroll through the list of devices and locate Ports (COM & LPT), as shown in the next fig-
ure.

File Action  Wiew  Help |

s @ HME @

iﬂ Intel(R) 82557LM Gigabit Mebwork Connection -
—W3, Microsoft Virtual WiFi Miniport Adapter
1 - [y Other devices il
» =] PCMCIA adapters
2 75 Pons (COM & LPT)
-T2 Silicon Labs CPZ10x USB to LIART Bridge (COME)
» 0 Processors
1 B} S0 host adapters
b Smart card readers

i

1|

3. Double-click the COM port to open the settings window. For example, in the previous fig-
ure, you would double-click the COM6 port.

Silicon Labs CP210x USE to UART Eridge (COMS) Properties

| General| Port Settngs | Driver | Details | Power Management|

e e (S
Data bits: (8 -
- 3
s 2
Elow controt | None -

| advanced.. | | Restore Defauts |
|
Lok J[ cenont |

4. Click Advanced to open the Advanced Settings window for the COM port.
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D-Style Motors: RS-232 with Protective Shunt

5. Move the Receive and Transmit Buffer sliders to Low (1), which is the minimum setting,
as shown in the following figure.

(¥ Lisa FIFD bffars (requires 16550 compaible UART!
Select bwer sefings 10 cormect connection problems, [—M
Select higher seltings for fasier performance. )

persuts | |

Recene Low ity L) High (14] (1)
|

Transmk Butfer: Low (1) U High (18] {1}

COM Port Humber: | COMS -

6. Click OK to save the new settings.

D-Style Motors: RS-232 with Protective Shunt

CBLSM1-xM

) -

CBLDC1

SHUNT42vioow > EENIm=:
or SHUNT42V200W

[

PS24VSAG-110 \_
or PS42V6AG-110 i
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D-Style Motors: RS-232 Multidrop with Add-A-Motor Cables

D-Style Motors: RS-232 Multidrop with Add-A-Motor Cables

CBLSM1-xM CBLSMADD-xM

PS24V8AG-110 or
/ PS42V6AG-110

D-Style Motors: RS-232 Multidrop with Custom X-Y-Z Cable

CBLSM1-X-Y-Z

D-Style Motors: DE Power Option Schematic

The DE power option allows the controller and drive-amplifier to be powered from separate
DC power supplies (see the following figure).
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D-Style Motors: CDS Option Schematic

CN2: 15-PIN D-SUB

PIN# | NAME

1 1/0-0
1/0-1
3 1/0-2
4 |1/0-3
5 1/0-4
6 |1/0-5
7
8

1/0-6

ENCODER A OUT

9 | ENCODERBOUT

10 [ RS-232 TRANSMIT
11 | RS-232 RECEIVE

12| +5VDCOUT

13 | SIGNAL GND

14 | CONTROL PWR GND
15 | CONTROL PWR

ololofeofolo|ofofolo|9|o(ofe]|O

CN1:7-PIN COMBO
PIN# | NAME

1 1/0-6
+5VDC OUT

2
3 [RS-232 TRANSMIT
4 | RS-232 RECEIVE

5 |GND

Qojolol|ofo

NOTE: The same supply may be used for
Control and Drive power, but maximum protection AL -

X X K . A2 | DRIVE PWR GND &
is provided with separate power supplies.

( )
Drive Amp Power Supply: DRIVE PWR GND o

Protective Shunt

(20-48VDC) DRIVE PWR O

E-Stop Switch . /
Control Power Supply: CONTROL PWR o
(20-48VDC) CONTROL PWR GND ©

NOTE: All M-style and IP-sealed SmartMotors are designed to a/lways have sep-
arate drive and control power. Therefore, no DE designation is available for these
SmartMotors.

D-Style Motors: CDS Option Schematic

This section provides a schematic for wiring a D-style SmartMotor equipped with the CDS CAN
connection option. This option can be used for Combitronic communications. For details on
Combitronic communications, see Combitronic Communications in the SmartMotor™
Developer's Guide. The option also allows the integrated brake option to be used with CAN,
which is useful for many vertical-axis applications.

NOTE: The CDS Option is available only on specially equipped D-style SmartMo-
tors. Contact Moog Animatics for details.

A special version of the D-style SmartMotor with the CDS CAN connector option allows simple
CAN bus network wiring through the DA-15 connector (15-pin D-sub I/O connector shown in
the following figure). This is an advantage when the M-style CAN connector is not desired. The
D-style motor with the CDS CAN connection option can be used as the terminating node. To
enable this, a 120 ohm shunt must be placed across pins 10 and 11. For details, see the fol-
lowing figure.

NOTE: Terminating resistors must always be used at both ends of a CAN bus net-
work.
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D-Style Motors: CDS Option Schematic

876 54321

OO00OOO0O
0000000 SRS E:h\
151413121110 9 ; -— 1
1/0 Connector : = — o de——r Motor as Terminating Node
Pin Numbers LAY | 5 —
\ﬁ" - S| 8T 120 Ohm Shunt Shield Drain
PIN_[DESCRIPTION | LO ¥ Qf/ ol -
10 [ CAN Low P @ D /a—
11| CAN High Cg’ T /; { 10 CAN Low
All other pins are as o o o o % 1; _ 11 CAN High
previously shown. \ 13—
@ 0. o\) 1t =
Trajectory Power/Servo (|
LED (Bt) LED g
o>}

120 Ohm
Shunt

120 Ohm
Shunt

10 CAN Low
11 CAN High
“““““ 13 Shield Drain

U} 15-pin D-sub Male “D UW 15-pin D-sub Male [U U} 15-pin D-sub Male [U

NOTES: A terminating resistor is required at each end of the bus.
Bus must be multi-drop as shown, not a star network.
24V CAN bus power connection is not required at the motor.

Schematic for CDS Option, D-Style SmartMotor Used as Terminating Node
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M-Style Motors: Connectors and Pinouts

M-Style Motors: Connectors and Pinouts

The following figure provides a brief overview of the connectors and pinouts available on the
M-style SmartMotors. Additional connector specifications are available in Class 5 M-Style Con-
nector Pinouts on page 67.

CANOPEN
5-Pin 5-Pin CANopen PIN | DESCRIPTION
Limit Inputs (female is standard) 1 |NC
4 2 +V (NC except DeviceNet)
LIMIT INPUTS 4 CANOPEN CANOPEN f\ 1 i -V (Unisolated Ground)
PIN | DESCRIPTION | RUN LED ERROR LED 3 %}' CAN-H
1_]+24vDCOut 3 \ ) g o LCANL
2 1/0-3 or -Limit 5 2
3 | GND-Common 2
4 | 1/0-2 or +Limit
5 1010 COMMUNICATION
. PIN | DESCRIPTION
© 8-Pin 1 GND-Common
COM Encoder Bus 2 | RS-485B CHO
3 RS-485A CHO
4 ENC A+ (In/Out)
5 ENC B- (In/Out)
I/Os 6 | ENCA-(in/Out)
PIN | DESCRIPTION 7 +5VDC Out
1 1/0-0 8 ENC B+ (In/Out)
2 1/0-1 RS-485 serial communication uses a
s Juos iage difrentel sl Approvioe
4 |1/0-5 12-Pin 110 on the RS-485 network to ensure reliable
5 |1/0-6 performance.
6 1/0-7
7 [os 12 TRAJECTORY POWER INPUT
8 |1/09 8,9 LED 4 PIN | DESCRIPTION
9 Not Fault Out 7 1 1 Control Power In 24Vmax
10 | Drive Enable In 6 10 2 | Chassis GND/Earth
11| +24VDC Out 5 2 o 3 3 | GND-Common
12 | GND-Common 11 43 4 | Amplifier Power 48Vmax

M-Style Motors: Power, RS-485 Com and CAN Multidrop

|

CBLIP-
TRM120

CBLIP-CAN-Y1-xM

RS232485T

CBLIP-
TRF120

24V - 48V 5

Drive Power —» CBLIP-PWR4-Y1-xM

] —

Separate 24V —>» CBLIP-PWR4-FL-xM
Control Power
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M-Style Motors: Power Multidrop

M-Style Motors: Power Multidrop

24V - 48V
Drive Power —»

Separate 24V —> CBLIP-PWR4-Y1-xM
Control Power

CBLIP-PWR4-FL-xM

15 Amps maximum continuous load

This power-connection method would be combined with a communications-connection
method. For example, see the diagrams in the following two sections.

M-Style Motors: RS-232 to RS-485 Multidrop

RS232485T
CBLIP-COM-FL (8 Pin)

il (=

CBLIP-COM-Y1-xM

NOTE: RS-485 serial communications uses a voltage differential signal that
requires proper termination with a 120 ohm resistor across pins 2 and 3 at both
ends of the network cable. This follows RS-485 standards for biasing to ensure reli-
able performance. The termination can be created by adding the resistor to CBLIP-
COM-FL Flying Lead cables or to off-the-shelf connectors.

This communications-connection method would be combined with a power-connection
method. For example, see M-Style Motors: Power, RS-485 Com and CAN Multidrop on page

44,
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M-Style Motors: CANopen or DeviceNet Multidrop

M-Style Motors: CANopen or DeviceNet Multidrop

PC, PLC,

etc. é’ﬂ CBLIP-CAN-FL (5 Pin)
(see NOTE)

CBLIP-CAN-Y1-xM

e (O
I

CBLIP-TRF120

NOTE: The bus requires a termination resistor at each end. If the master device
(PC, PLC, etc.) does not include one, then an external termination resistor must be
supplied.

This communications-connection method would be combined with a power-connection
method. For example, see M-Style Motors: Power, RS-485 Com and CAN Multidrop on page
44.
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Understanding the Status LEDs

Understanding the Status LEDs

The Status LEDs provide the same functionality for the D-style and M-style (including IP-
sealed) SmartMotors.

P4

(Limit Inputs) ___

LED 3 P5 P2 (/0 Connector)
LED 2 (CANopen)

LED 0
P1 (Main Power)

P3 LED 1 S
(/0 Cor
LED 2
LED 1
Erecam Bus) I¥' P3 (CANopen option)
P1 (Power Input)
P4 (EXPANDED I/O option)
/LED 0: Drive Status Indicator A /LED 2: CAN Bus Network Fault (Red LED) A
Off No power Off No error
Solid green Drive on Single Flash At least one error
Flashing green  Drive off exceeded limit
Flashing red Watchdog fault Double Flash Heartbeat or guard error
Solid red Major fault Solid Busy off state
Alt. red/green In boot load; needs firmware LED 3: CAN Bus Network Status (Green LED)
LED 1: Trajectory Status Indicator Blinking Pre-operational state
Off Not busy (during boot-up)
Solid green Drive on, trajectory in progress 20“‘1 Normal operation
ingle Device is in stopped state
\ AN J

LED Status on Power-up:
» With no program and the travel limit inputs are low:
LED 0 will be solid red indicating the motor is in a fault state due to travel limit fault.

LED 1 will be off.

» With no program and the travel limit inputs are high:
LED 0 will be solid red for 500 milliseconds and then begin flashing green.

LED 1 will be off.

» With a program that disables only travel limits and nothing else:
LED 0 will be solid red for 500 milliseconds and then begin flashing green.
LED 1 will be off.

NOTE: D-style motors with the CDS CAN connector option use LED 1 to indicate a CAN error. Because this LED also
indicates the trajectory status, it will alternate red/green colors if a CAN error occurs while a trajectory is in progress.

D-Style Motor CDS Option LED 1 CAN Error Indication:

Condition Indication Bt refers to Busy Trajectory

Bt = 0, CAN bus OK Trajectory LED = Off status bit. When the motor is

Bt = 1, CAN bus OK Trajectory LED = Green actively pursuing a trajectory,
) . that bit will be set to 1.

Bt = 0, CAN bus fault Trajectory LED = Flashing red

Bt = 1, CAN bus fault Trajectory LED = Alternating red/green
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Detecting and Addressing the SmartMotors

Detecting and Addressing the SmartMotors

This section describes how to detect and address the motors over the serial network. For
details on other communications methods, see Communication Details in the SmartMotor™
Developer's Guide.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System
on page 36.

- The SmartMotor is connected to a power source. (M-style motors require separate con-
trol and drive power.) For details, see Understanding the Power Requirements on page
33 and Connecting the System on page 36.

« The SMI software has been installed and is running on the computer. For details, see
Installing the SMI Software on page 29.

Understanding the Detection and Addressing Options

There are three different ways to use the SMI software to find and address the D-style
SmartMotors that are connected to your PC:

« Use the Find Motors button—this method is recommended for first-time communications
or when you don't know the port used to connect the motors. For details, see Using the
Find Motors Button on page 50.

« Use the Detect Motors feature—this method can be used if you know the com-
munications port used to connect your motors and if your motors may be pre-
addressed. For details, see Using the Detect Motors Feature on page 52.

» Use the Address Motors feature—this method can be used if you know the com-
munications port used to connect your motors. This method always re-addresses the
motors; therefore, if you have pre-addressed motors connected, their addresses may
be changed. For details, see Using the Address Motors Feature on page 54.

These methods are described in the following sections.
A note about M-style motors:

The M-style SmartMotors only work on RS-485 and, therefore, need to be pre-addressed in
nonvolatile memory such as a user program before being daisy-chained together and detec-
ted. To do this, you must:

1. Connect the first motor, address it (typically as motor 1), remove it,
2. Connect the second motor (typically as motor 2), address it, remove it,
3. And so on, until all motors have been pre-addressed.

After all the M-style motors are addressed:

4. Daisy-chain the motors as shown in Connecting the System on page 36.

5. Use the Detect Motors feature. For details, see Using the Detect Motors Feature on page
52.
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Understanding the Detection and Addressing Options

CAUTION: Do NOT use the Address Motors feature. Doing so will overwrite
the existing motor addresses.

Some notes about motor addressing:

The SmartMotors power up in non-echo state (so no response is sent to the next motor), 9600
KB communications and a Base address of 0 (zero).

As the system addresses the motors in the RS-232 daisy chain (remember, as discussed in the
previous note, M-style motors use RS-485 and must be pre-addressed), it starts with the first
motor in the daisy chain, sets its address to 1, enables echo, and then puts that motor to
sleep. It proceeds to the next motor in the daisy chain, sets its address to 2, enables echo and
puts it to sleep. This process continues until all the motors in the daisy chain are addressed.

When the motor is addressed, it contains a unique identifier that allows it to respond to com-
mands intended for that motor and ignore commands intended for other motors. For example,
1RPA reports the position from motor 1 only; all other motors in the daisy chain ignore the
command. However, a global command, like ORPA, reports the positions from a/l motors. For
more details on addressing and daisy chaining, see Daisy Chaining Multiple SmartMotors in
the SmartMotor™ Developer's Guide.

Motor addresses are activated and stored as follows:
o For serial addresses:

« These are stored in the SmartMotor's volatile memory, which means they are lost
when motor power is turned off.

« After setting the address, it goes into effect immediately (do not reboot or per-
form a system reset with the Z command; either of these actions will delete the
addresses).

o For CAN addresses:

» These are stored in the SmartMotor nonvolatile memory (NVRAM), which means
they are retained when motor power is turned off.

» After setting the address, it doesn't go into effect until the system is restarted or
reset.

« The CAN address of a motor is different than the serial address (because they are
communicating on different networks). However, for ease of use, you can "store"
the serial address in the CAN address by entering the command:

CADDR=ADDR

Then, whenever you reset the system (either with the Z command or turning the
power off and back on), you can recall the serial addresses of the motors from the
stored CAN addresses, by entering the command:

OADDR=CADDR

Because the CAN address is permanently stored and doesn't change on power off
or reset, this allows you to easily restore specific serial addresses. This method
also works for DeviceNet, PROFIBUS and other industrial networks.

When addressing the motors, you can address serial and CAN in the same command, which
means you can use the serial network to communicate with the CAN bus. The leading number
is the serial address; the number following the colon character is the CAN address. Consider
this example:

Moog Animatics Class 5 SmartMotor™ Installation & Startup Guide, Rev. A
Page 49 of 70



Using the Find Motors Button

1RPA:2

The leading "1" is addressing the serial network motor 1; the ":2" is addressing the

CAN network motor 2. In this example, the command is going out on the serial network to
motor 1, then out the CAN port to motor 2, reading motor 2 position info, and then echoing it
back to the host from CAN to motor 1 and then serial to host.

Using the Find Motors Button

The easiest way to locate any connected SmartMotor is to use the Find Motors button (see the
following figure). This method searches every communications port (serial, USB, Ethernet,
etc.) on the PC. If you don't know which port your motor is connected to, this method is the
most thorough way to search. However, if you have many ports, this method can also take a
long time.

To begin searching for motors across all ports on the PC, in the Configuration window of the
SMI software interface, click Find Motors. The SMI software begins searching for all SmartMo-
tors connected to the PC.

Cormpade Tools Window Help

EE b AR AN Y »m 00 EHW?

Camd | Coms | Coms  Etheinel | US| CAM Chanred 0 |

iy Carmmumication

Firad Modous

Detected Configuralion
3 Comd [RS23249500 bes)
' Comf [RS2229500 bps)
j Comb [RS232-3600 bpz)
Etherniet
o USD
_a'_ C&N Chismmel 0125000

I~ Opsn |r-'kl Miohors llElhrn:l Poil

Serd

Dretecting SmanMobors o R5-232 daisy chain: "ComE". Flease wai..

ERRREREEENN
e |

| L..| Desciiption
i Delechng Smatolos on R5-232 dasy chan "Comb"

] 3

Faor Help, press FL

Find Motors Detecting SmartMotors on the RS-232 Chain

After the motors are detected, the SMI software will address them if needed. The following
steps are only used when the SMI software finds motors that do not have addresses.
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Using the Find Motors Button

To address the motors, click Yes when you see the following prompt.

Ml s abouk to by and address the motors, This will issus an END command causing
* the rurining program to stop execution. Do you wish SMI to continue?

Mo |

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software
addresses the motors. During this process, the SMI software is collecting the following inform-
ation on each motor. The information is the same as that shown in the Motor View window,
which can be accessed by selecting the Tools > Motor View > Info tab:

s o - .4 |-.I
# Motor View - “Motor3-Cor ! .

Motar Name: |Motorl-Comt
Motor Address: |3
Veersior: [5.0.3.44
Sesial Nurber. |E137753
Model |3M231650-CAD1T

Sample Penod: |[|.'|25‘[|I]EI mSec.
Program Mame: |(EHD)
Diowrdoad Tirne: |EMJ'I]9.-'2EI'|3 12:08:41 [Frtddy bem:z)
Program Size: |31 Bytes

Ship Dater |I]?..-'21E2I]12
Frmware Date: |Feh 26 2013171200

~ Scaling
Mo scale 1z defined for thiz motor. To defme scale, cick the "Edit
Fropesties" button.

Display ADB Save ADE

Dietailz Edit Fropeities Get Info

Motor View Information
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Using the Detect Motors Feature

After the process has completed, the SMI software shows the found motors in the Con-
figuration window under the corresponding communications port. Each motor is represented
by a motor icon; the motor's address and firmware version are shown next to the motor icon.

| Find Mators |

El--E [I_I__ete-::ted Configuration
r;’f Comd [RS232-9600 bpsz)
Comb [R5232-3600 bps

Comb (F5232-9600 bps)
8 Motor-Com (5.0.3.44)

Ethernet
ISE

% CaM Channel O [125000 bpsz]

Configuration Window Showing Found/Addressed SmartMotor

Using the Detect Motors Feature

This method is similar to the Find Motors method, but it searches only the specified com-
munications port for connected SmartMotors. This is also the recommended method for detect-
ing M-style motors after they have been pre-addressed and daisy-chained to the
communications port.

To use the Detect Motors feature, in the Configuration window of the SMI software, right-click
the desired communications port and select Detect Motors from the menu.

Find Matars ‘ Comnd ] Carn5 ] Comg  F

¥ Open | Al Maotors

E--E Detected Configuration
“_luy" Carnd [RS232-9600 bps)

;,f Comb [R5 232-9600 bps)
M Comb [FS232-9600 bos!

LAE00 bosl

Ethermnet
& USE
[ CaM Channel O

Selecting the Detect Motors Feature

Properties

I Detect Motors on R5-232 Chain I
Set Baudrate
Address R5-232 Chain

Download firmware

The SMI software begins searching for all SmartMotors connected to the specified com-
munications port. A progress bar is shown while the SMI software searches for the motors.

After the motors are detected, the SMI software will address them if needed. The following
steps are only used when the SMI software finds motors that do not have addresses.
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Using the Detect Motors Feature

To address the motors, click Yes when you see the following prompt.

Ml s abouk to by and address the motors, This will issus an END command causing
* the rurining program to stop execution. Do you wish SMI to continue?

Mo |

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software
addresses the motors. During this process, the SMI software is collecting the following inform-
ation on each motor. The information is the same as that shown in the Motor View window,
which can be accessed by selecting the Tools > Motor View > Info tab:

s o - .4 |-.I
# Motor View - “Motor3-Cor ! .

Motar Name: |Motorl-Comt
Motor Address: |3
Veersior: [5.0.3.44
Sesial Nurber. |E137753
Model |3M231650-CAD1T

Sample Penod: |[|.'|25‘[|I]EI mSec.
Program Mame: |(EHD)
Diowrdoad Tirne: |EMJ'I]9.-'2EI'|3 12:08:41 [Frtddy bem:z)
Program Size: |31 Bytes

Ship Dater |I]?..-'21E2I]12
Frmware Date: |Feh 26 2013171200

~ Scaling
Mo scale 1z defined for thiz motor. To defme scale, cick the "Edit
Fropesties" button.

Display ADB Save ADE

Dietailz Edit Fropeities Get Info

Motor View Information
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Using the Address Motors Feature

After the process has completed, the SMI software shows the found motors in the Con-
figuration window under the corresponding communications port. Each motor is represented
by a motor icon; the motor's address and firmware version are shown next to the motor icon.

| Find Mators |

ElE [I_I__ete-::ted Configuration
- r;’f Comd [R5232-9600 bps)
- Comb [RS232-9600 bps

- Com [R5232-9600 bps]
@B Motor!-Com [5.0.3.44]

----- Ethernet
gy USE
----- CaM Channel O [125000 bpsz]

Configuration Window Showing Found/Addressed SmartMotor

Using the Address Motors Feature

This method assumes that there are motors connected to the specified port and will simply
address each one that it finds.

NOTE: This method will address (or re-address) every motor. If you pre-addressed
your motors before connecting them, those motor addresses could be changed by
this process.

To use the Address Motors feature, in the Configuration window of the SMI software, right-
click the desired communications port and select Address RS-232 Chain from the menu.

Find Moatars ‘ Comd ] Comb ] Comf  E
EE Detected Configuration v Open |&l Motors

“y‘ Cornd (R5232-9600 bps) |

- ComS [R3232-9500 bps] =

“_}gf Comb | |
Ethernet
[ U3 Detect Motors on R5-232 Chain
[ CAM Channel O
Set Baudrate 3

| Address RS-232 Chain |
Selecting the Detect Motors Feature

Download firmware
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Using the Address Motors Feature

To address the motors, click Yes when you see the following prompt.

Ml s abouk to by and address the motors, This will issus an END command causing
* the rurining program to stop execution. Do you wish SMI to continue?

Mo |

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software
addresses the motors. During this process, the SMI software is collecting the following inform-
ation on each motor. The information is the same as that shown in the Motor View window,
which can be accessed by selecting the Tools > Motor View > Info tab:

s o - .4 |-.I
# Motor View - “Motor3-Cor ! .

Motar Name: |Motorl-Comt
Motor Address: |3
Veersior: [5.0.3.44
Sesial Nurber. |E137753
Model |3M231650-CAD1T

Sample Penod: |[|.'|25‘[|I]EI mSec.
Program Mame: |(EHD)
Diowrdoad Tirne: |EMJ'I]9.-'2EI'|3 12:08:41 [Frtddy bem:z)
Program Size: |31 Bytes

Ship Dater |I]?..-'21E2I]12
Frmware Date: |Feh 26 2013171200

~ Scaling
Mo scale 1z defined for thiz motor. To defme scale, cick the "Edit
Fropesties" button.

Display ADB Save ADE

Dietailz Edit Fropeities Get Info

Motor View Information
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Checking and Clearing the Status Bits

After the process has completed, the SMI software shows the found motors in the Con-
figuration window under the corresponding communications port. Each motor is represented
by a motor icon; the motor's address and firmware version are shown next to the motor icon.

| Find Mators |

=-4&l Detected Configuration
- 5 Comd [RS232-9500 bps)
S Comb (RS 232-9500 bps
Comé [RS232-9600 bps)
@B Motor!-Com [5.0.3.44]

----- Ethernet
gy USE
----- CaM Channel O [125000 bpsz]

Configuration Window Showing Found/Addressed SmartMotor

Checking and Clearing the Status Bits

NOTE: In addition to the software information in this section, there is context-sens-
itive help available within the SMI software interface, which is accessed by press-
ing the F1 key or selecting Help from the SMI software main menu.

The Motor View window is used to view and monitor various motor parameters. It is used in
conjunction with the Terminal window to clear any active overtravel limits.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System
on page 36.

- The SmartMotor is connected to a power source. (M-style motors require separate con-
trol and drive power.) For details, see Understanding the Power Requirements on page
33 and Connecting the System on page 36.

« The SMI software has been installed and is running on the computer. For details, see
Installing the SMI Software on page 29.

» The SmartMotor has been detected and addressed. For details, see Detecting and
Addressing the SmartMotors on page 48.
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Polling the Motor

Polling the Motor

To view the current state of the status bits, you must poll the motor.

1. Double-click the motor icon to open the Motor View window (see the following figure).

2. Click the Poll button to begin polling data from the motor.

Status | Inifi ] I'-'Innilnr| Uzer Variahles] Flags I I:aln:ulatiuns] Trace I

e sep | o |GEOIDEN  fooe

M Sesled [ Hex Display

' Positions 11307
Pos. Eror: (]
Yelociy:

— Input/Output; — Red Sy, Grey Oy - —

0123 456
LR B K B X N

StaluzWord D+

0} Drive ready

1@ Bo: Motor is off

2 ) Bt Trajectory in progress

3 ) Bus voltage fault

4 () Ba: Over-current occurred

5 Bh: Excessive temperature fauk

£ {J Be: Excessive position error

7 {3 Bv: Velocity limit

8 Realtime temperature limit

9} deidt error imi
10 @ Positive HW limit enabled
11 @ Megative HW limit enabled
12 @ Br: Historical positive HAY limit
12 @ Bi: Historical negative HIW limit
14 @ Bp: Positive HW limit asserted
15 @ Bm: Negative HW limit asserted

Cleat Flags [£5])

Ver: 5.0.3.44 Model: SM23165D.C.AD1

Motor View with Active Overtravel Limits

A SmartMotor with no program and no I/0 connections will boot up with active overtravel lim-

its (see the red status bits numbered 10 through 15 in the previous figure).

The EIGN() command is used to clear these status bits as described in the next section. EIGN
stands for: Enable Inputs as General Use. In the case of EIGN(W,0), the W means a "word" or
16 bits of I/0; the 0 means first word or local I/0. There are only seven local I/O on the
D-style motors. Therefore, EIGN(W,0) sets all seven I/0 to general-use inputs.
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Clearing the Overtravel Limits and Fault Bits

Clearing the Overtravel Limits and Fault Bits

To disable (clear) the overtravel limits, enter EIGN(2) and EIGN(3) in the SMI software Ter-
minal window. This sets I/O 2 (positive overtravel limit) and I/O 3 (negative overtravel limit)
as general inputs/outputs instead of being used as travel limits. To set all status bits in Word O
as general inputs/outputs, enter EIGN(W,0).

NOTE: You can either type the command in the white text box or type the com-
mand directly in the blue area of the terminal screen and then click Send or press
Enter.

The active and asserted bits are cleared, as shown in the following figures.

Comd | Com5 Comé | Ethemet | USB | CAN Channel 0] 10 &3 Positive HAW limit enabled
¥ Open  [AlMotors =] |Comé S600RSZ32ChOENT 1162 Negative HW limit enabled
|EII3N[W_IJ] o I 12 @ Br: Historical positive HW limit

13 @ B Historical negative HIW limit
14 {3 Bp: Positive HW limit asserted
15 (3 Bm: Megative HAY limit asserted

EIGN Command Entered Active and Asserted Bits Cleared

To clear the historical fault bits, enter ZS. All remaining fault bits are cleared, as shown in the
following figures.

Com4 | Com5 Comb | Ethemet | USE | CAN Channel 0|

— — - 10 {3 Positive HAW limit enabled
¥ Open  [AlMalees v ||CamB 9500, L 11 (3 Negative HAW limit enabled

| _ Send | 12 (3 Br: Historical positive HAW limit
13 (3 Bl Historical negative HAV fimit
14 (3 Bp: Positive HAW limit azzerted
15 {3 Bm: Megative HAV limit azserted

Addressing the Motors (RS232)... Dane

EIGH (W, D)

75
Fat=)

ZS Command Entered Remaining Bits Cleared
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Moving the SmartMotor

Moving the SmartMotor

NOTE: In addition to the software information in this section, there is context-sens-
itive help available within the SMI software interface, which is accessed by press-
ing the F1 key or selecting Help from the SMI software main menu.

The SMI software contains a Torque mode that is used to test the motor response and ensure
the drive is operating properly.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System
on page 36.

» The SmartMotor is connected to a power source. (M-style motors require separate con-
trol and drive power.) For details, see Understanding the Power Requirements on page
33 and Connecting the System on page 36.

» The SMI software has been installed and is running on the computer. For details, see
Installing the SMI Software on page 29.

« The SmartMotor has been detected and addressed. For details, see Detecting and
Addressing the SmartMotors on page 48.

« The Drive Enable input on the M-series motor must be connected and activated with
24V. For the input location, see M-Style Motors: Connectors and Pinouts on page 44.

« The overtravel limits and fault bits have been cleared. For details, see Checking and
Clearing the Status Bits on page 56.

Making the Motor Move

WARNING: The larger SmartMotors can shake, move quickly and exert great

force. Therefore, proper motor restraints must be used, and safety pre-
cautions must be considered in the workcell design (see Other Safety Con-
siderations on page 9).

To make the SmartMotor move:

1. Inthe Terminal window, select the tab that matches the communications channel to
which your motors are connected. To do this, look at the Configuration window, find the
channel where the motors are listed and click that tab name in the Terminal window.

Configuration
| Fird Matars ||| coms | Enm5| Comé IEIhernel| USE | CAM Charned il |
ikl Detectad Configuration WM] Motz |[ComE, 9500 AS232 Chi0 3N

J Caird [H5232 amn bea]

<1l Send

1)
& w-;rzcwa[s U 244

Ethmamet
use

2 CAM Charnel 0 (125000 bps)

Tab Selected that Matches the Communications Channel
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Setting and Reporting Torque

NOTE: If you do not have the correct tab selected, the commands you enter
will not go to the motors and there will be no response.

2. Enter the following commands in the Terminal window:

Terminal

Comé | Com  Comb | Ethemet | USE | CAM Channel 0 |
W Open |allMotors v ||ComB,9600,RS 232 Chi0 6N1

| Send

MT

T=32000

G

You should immediately see the motor shaft moving in the positive direction (clockwise,
when looking at the end of the motor shaft). If the motor does not respond to the com-
mands, see Troubleshooting on page 64 for troubleshooting tips.

NOTE: Macros (shortcut keys) can be used to simplify entry of frequently-
used commands. For details, see Macros in the SmartMotor™ Developer's
Guide.

3. After you have observed the motor shaft turning, enter the X command to decelerate
the motor to a stop.

Setting and Reporting Torque

The following commands are related to the previous motion procedure. For more details on
these commands, see the SmartMotor™ Command Reference Guide.

MT (Mode Torque)

MT sets the mode of operation to torque mode. In this mode, the SmartMotor shaft applies a
torque independent of position. For more details, see Torque Mode in the SmartMotor™
Developer's Guide.

T=formula (Set Target Torque)

T can be set to any value from -32767 to +32767, which represents -99.99% to +99.99% PWM
(pulse-width modulation) commanded.

RTRQ (Report Actual Torque)

Enter RTRQ at the Terminal window to report the commanded torque from the trajectory gen-
erator.

Note that RTRQ typically reports a value that's one less than the T value. In the previous
example, T=3000, but RTRQ reports 2999. This is due to zero being counted as the least
amount of torque commanded. TRQ is always % PWM commanded to the motor at any time
and in any mode of operation. It can be used to transfer across modes without a ripple or
bump in force applied to the load.

TS (Set Torque Slope)

The TS command defines how fast the processor applies a change in torque. For an example
of the TS command, see the Chart View Example in the SmartMotor™ Developer's Guide.
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Checking the Motor Position

Torque slope can range from -1 to 2147483647 (default). At a value of 65536, the processor
changes torque by a value of 1 for each PID sample. The default sample rate is 8000; you can
view the current sample rate with the RSAMP command.

Checking the Motor Position

There are several ways to check the motor position:

« Report the position using commands from the Terminal window
» View the position in the Motor View tool

These two methods are described in the following sections. You can also view the position in
the Monitor or Chart View software tools. For details, see SMI Software Features in the
SmartMotor™ Developer's Guide.

This procedure assumes that:

« The SmartMotor is connected to the computer. For details, see Connecting the System
on page 36.

« The SmartMotor is connected to a power source. (M-style motors require separate con-
trol and drive power.) For details, see Understanding the Power Requirements on page
33 and Connecting the System on page 36.

« The SMI software has been installed and is running on the computer. For details, see
Installing the SMI Software on page 29.

« The SmartMotor has been detected and addressed. For details, see Detecting and
Addressing the SmartMotors on page 48.

« The overtravel limits and fault bits have been cleared. For details, see Checking and
Clearing the Status Bits on page 56.

Viewing the Motor Position with a Report Command

To report the motor position, in the Terminal window, issue the RPA (Report Position Actual)
command:

RPA

The terminal responds with the current position of the motor:
RPA 3593657

NOTE: The position is reported on the same line as the command; there is no line
feed or carriage return for "report" commands.

The RPA command reports the actual motor position at the time the command was issued.
Therefore, it is just a "snapshot"—if the motor is moving, the reported position is not dynam-
ically updated.

Viewing the Motor Position with the Motor View Tool

The Motor View tool provides another way to view the motor position. The advantage of using
this tool is that the position is dynamically updated when the motor is moving.
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Viewing the Motor Position with the Motor View Tool

To open the Motor View tool, from the SMI software Configuration window, right-click the
motor you want to view and select Motor View from the menu.

| Find Motors ||} coms | coms Comb |
k&l Detected Configuration ¥ Open  [aiiMotars

-7 Comd [R5232-9600 bps) |
b Comf [R5 232-9600 bes)
= Comé (R5232-9600 bps)

P Motond( “““’""""E
i Ethemet Properties

[ LISE
P CAM Char Set Motor Address

SmartMotor Playground

Opening the Motor View Tool

After the Motor View window opens, click the Poll button to begin polling (getting information
from) the motor. After polling begins, the motor position is shown in the Position box.

Status [Irﬂn | Moritor | Usuer‘-.l’aiable's] Flags | Calculaticml Tral:e]

SN S Oniine
T Scaled 3

Positior: Stabus Ward I

P, Emar: )
Yelacity 0@ Drive ready
Mode: 1 Bo: Motor is off

. 2 (3 Bt Trajeciory in progress

None j' 3 {J Bus voltage fault
More *-'I 4 {J Ba: Over-current occurred

5 {2 Bh: Excessive temperature fault

~Input/Output — Red Sv.Grey Ov - — | 6.3 Be: Excessive postion error
D1 2 3 4 5 B 70 Bv: Velociy imit
2000 0OG® 8 O Reakfime temperature limit

93 defdt error lmit

10 (3 Postive HAY Emit enabled

11 3 Negative HAW limit enabled

12 (J Br Historical positive H/W fimit

13 {3 Bl Historical negative HAY Emit

14 3 Bp: Posfive HAY limit asserted

153 Bm: Negative HAW limit asserted

Clear Flags [£5]

Motor View Tool Showing the Motor Position
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For Further Information...

For Further Information...

Now that your SmartMotor is installed and operating, the next step is to learn about its fea-
tures, commands and programming in order to create a useful application.

Information on SMI software features, SmartMotor programming, communications, motion
control and more is provided in the SmartMotor™ Developer's Guide. That guide also includes
a complete SmartMotor command reference, and an Appendix of other related topics that are
useful during application development.
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Troubleshooting

Troubleshooting

The following table provides troubleshooting information for solving common problems. For
additional support resources, see the Moog Animatics Support page at:

http://www.animatics.com/support.html

Issue

Cause

Solution

Communication and Control Issues

Motor control power
light does not illu-
minate.

Control power is off, dis-
connected or incorrectly
wired.

Check that control power is connected to
the proper pins and turned on. For con-
nection details, see Connecting the Sys-
tem on page 36.

Motor has routed drive
power through drive-
enable pins.

Ensure cabling is correct and drive power
is not being delivered through the 15-pin
connector.

Motor is equipped with
the DE option.

To energize control power, apply 24-48
VDC to pin 15 and ground to pin 14.

Motor does not com-
municate with SMI.

Transmit, receive or
ground pins are not con-
nected correctly.

Ensure that transmit, receive and ground
are all connected properly to the host PC.

Motor program is stuck
in a continuous loop or
is disabling com-
munications.

To prevent the program from running on
power up, use the Communications
Lockup Wizard located on the SMI soft-
ware Communications menu.

Motor disconnects
from SMI sporad-
ically.

COM port buffer settings

Adjust the COM port buffer settings to

are too high. their lowest values.
Poor connection on Check the serial cable connections and/or
serial cable. replace it.

Power supply unit (PSU)
brownout.

PSU may be too high-precision and/or
undersized for the application, which
causes it to brown-out during motion.
Make moves less aggressive, increase
PSU size or change to a linear unreg-
ulated power supply.

Motor stops com-
municating after
power reset, requires
re-detection.

Motor does not have its
address set in the user
program. NOTE: Serial
addresses are lost when
motor power is off or
reset.

Use the SADDR or ADDR= command
within the program to set the motor
address.

Red PWR SERVO light
illuminated.

Critical fault.

To discover the source of the fault, use
the Motor View tool located on the SMI
software Tools menu.

Common Faults

Bus voltage fault.

Bus voltage is either too
high or too low for oper-
ation.

Check servo bus voltage. If motor uses
the DE power option, ensure that both
drive and control power are connected.
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Troubleshooting

Issue Cause Solution
Overcurrent Motor intermittently Consider making motion less abrupt with
occurred. drew more than its softer tuning parameters or acceleration

rated level of current.
Does not cease motion.

profiles.

Excessive tem-
perature fault.

Motor has exceeded
temperature limit of
85°C. Motor will remain
unresponsive until it
cools down below 80°C.

Motor may be undersized or ambient tem-
perature is too high. Consider adding heat
sinks or forced air cooling to the system.

Excessive position
error.

The motor's com-
manded position and
actual position differ by
more than the user-sup-
plied error limit.

Increase error limit, decrease load or
make movement less aggressive.

Historical pos-
itive/negative hard-
ware limit faults.

A limit switch was
tripped in the past.

Clear errors with the ZS command.

Motor does not have
limit switches attached.

Configure the motor to be used without
limit switches by setting their inputs as
general use.

Programming and SMI Issues

Several commands
not recognized during
compiling.

Compiler default firm-
ware version set incor-
rectly.

Use the Compiler default firmware ver-
sion option in the SMI software Compile
menu to select a default firmware version
closest to the motor's firmware version.
In the SMI software, view the motor's
firmware version by right-clicking the
motor and selecting Properties.
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Class 5 D-Style Connector Pinouts

Class 5 D-Style Connector Pinouts

The following table shows the pinouts for the connectors on the Class 5 D-style SmartMotors.

> > 0ok wN
=

2

N

10
1"
12
13
14

a b~ W N =

©ONOO R WN =

1/0 - 6 GP, Index Input or “G” Command

+5 VDC Out

RS-232 Transmit
RS-232 Receive

SIG Ground

Main Power: +20-48VDC
Ground

1/0 — 0 GP or Encoder A or Step Input

1/0 — 1 GP or Encoder B or Direction Input
1/0 — 2 Positive Over Travel or GP

1/0 — 3 Negative Over Travel or GP

1/0 — 4 GP, IIC or RS-485 A (Com ch. 1)
1/0 -5 GP, IIC or RS-485 B (Com ch.1)
1/0 — 6 GP, Index Input or “G” Command

Phase A Encoder Output
Phase B Encoder Output
RS-232 Transmit

RS-232 Receive

+5 VDC Out

SIG Ground

Ground

Main Power: +20-48 VDC

NC

+V

-V (ground)
CAN-H
CAN-L

/0 -16 GP
1/0-17 GP
/0 -18 GP
/0 -19 GP
1/0 -20 GP
/0 -21GP
/0 - 22 GP
I/0 - 23 GP
I/0 — 24 GP
1/0 - 25 GP
+24 Volts Input
GND-I/O

25 mAmp Sink orSource
10 Bit 0-5 VDC A/D

50 mAmps Max (total)
Com ch. 0

Comch. 0

25 mAmp Sink or Source
10 Bit 0-5 VDC A/D
25 mAmp Sink or Source
10 Bit 0-5 VDC A/D
25 mAmp Sink or Source
10 Bit 0-5 VDC A/D
25 mAmp Sink or Source
10 Bit 0-5 VDC A/D
25 mAmp Sink or Source
10 Bit 0-5 VDC A/D
25 mAmp Sink or Source
10 Bit 0-5 VDC A/D
25 mAmp Sink or Source
10 Bit 0-5 VDC A/D

Com ch. 0
Com ch. 0
50 mAmp Max (total)

If DE Option, Control
Power separate from Main
Power

NC
NC except DeviceNet

Common Ground
1 MBaud Max
1 MBaud Max

150 mAmps
150 mAmps
150 mAmps
150 mAmps
300 mAmps
300 mAmps
300 mAmps
300 mAmps
300 mAmps
300 mAmps
18-32 VDC

Redundant connection on

1/0 connector 7W2 Combo

D-Sub Connector

oLERY e

115.2 KBaud Max
115.2 KBaud Max

1.5 MHz Max as Encoder
or Step Input

1.5 MHz Max as Encoder
or Direction Input

P2 DB-15 D-Sub Connector
115.2 KBaud Max

876 54321

115.2 KBaud Max

Redundant connection on
Main Power Connector

151413121110 9

115.2 KBaud Max
115.2 KBaud Max

M12 5-Pin
Female

4
2

Input current < 10 mA
Isolated

M12 12-Pin
Female End View

P2 15-Pin D-Sub /0

P4 12-Pin Expanded I/0 Connector

P1 7-Pin Combo
D-Sub Power
&1/0

oo
000

o
> Jo

LED

P3 5-Pin CAN

CAUTION: Pins 14 and 15 are intended

for use with DE series motors for control
power only. Attempting to power a non-DE
motor through those pins, as main
servo-drive power, may result in immediate
damage to the electronics, which will void
the warranty.

(female is standard)
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Class 5 M-Style Connector Pinouts

Class 5 M-Style Connector Pinouts

The following table shows the pinouts for the connectors on the Class 6 M-style SmartMotors.

1 Control Power In +12.5V Min, 32V Max Also supplies 1/0 M16 4-Pin Male
2 Chassis ! 5 O ¢
3 Control, Com, 1/0O and Amplifier Ground Common Ground Unisolated @
4 Amplifier Power In +12.5V Min, 48V Max Powers Amplifier Only e 3
1 Control, Com, 1/0 and Amp Ground Common Ground Unisolated
2 RS-485 B, Comch. 0 115.2 KBaud Max M12 8-Pin
3 RS-485 A, Com ch. 0 115.2 KBaud Max Female End View
4 Encoder A+ Input/Output 1.5 MHz Max as Encoder  Configurable as Encoder
or Step Input Output
5 Encoder B- Input/Output 1.5 MHz Max as Encoder ~ Configurable as Encoder
or Direction Input Output
6 Encoder A- Input/Output 1.5 MHz Max as Encoder ~ Configurable as Encoder
or Step Input Output
7 +5V Out 250 mA Max
8 Encoder B+ Input/Output 1.5 MHz Max as Encoder  Configurable as Encoder
or Direction Input Output
1 /10-0 GP 150 mAmps Max
2 1/10-1 GP 150 mAmps Max M12 12-Pin
3 I/O—4 GP 150 mAmps Max Female End View
4 /0 =5 GP or Index 150 mAmps Max
5 /0 -6 GP or “G” Command 150 mAmps Max
6 /10-7 GP 150 mAmps Max
7 /0 — 8 GP or Brake Line Output 300 mAmps Max
8 /10-9 GP 300 mAmps Max
9 Not Fault Out 150 mAmps Max
10 Drive Enable Input 150 mAmps Max
1 +24 \olts Out 12.5V Min, 28V Max
12 Ground Common Common Ground Unisolated
1 +24 Volts Out From Control Pwr In M12 5-Pin
2 1/0 -3 GP -Limit 150 mAmps Max Configurable FErrlaIe End View
3 Ground Common Ground Unisolated 3 51
4 1/0 -2 GP +Limit 150 mAmps Max Configurable
5) 1/10 - 10 GP 150 mAmps Max Configurable 2
1 NC NC M12 5-Pin
2 +V NC except DeviceNet Input current < 10 mA Female (std) Male (opt)
3 -V (ground) Common Ground Unisolated N . AR\ 2
4 CAN-H 1 MBaud Max s @ s
5 CAN-L 1 MBaud Max 1
pa LED3 LED 2 ;‘_5Pin CANopen _CAUTION: Exceeding 32 VDC
5-Pin (female is standard) into control power on any of
Limit Inputs

L

P3
12-Pin I/0

LED 1

P2
8-Pin
COM Encoder Bus

P1 4-Pin Power Input

the +24V pins may cause
immediate damage to the
internal electronics.
Exceeding a sustained voltage
of 48V to pin 4 of the P1 Power
Input may cause immediate
damage to the internal
electronics.

Exceeding these voltage limits
will void the warranty.
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